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Nord Sound Manager

NORD SOUND MANAGER

The Nord Sound Manager is an application which allows you to organize the various memory areas, or partitions in a Nord instrument. It is also used
to download pianos, samples, programs or performances to the Nord instrument or to upload any of these items - called sounds - from the instru-
ment’s memory to the computer hard drive. The Nord Sound Manager provides various methods for downloading sounds to the instrument and
functions for backing up and restoring the entire content of a Nord instrument.

System requirements

The Nord Sound Manager is compatible with computers running Mac OSX 10.4 or later, Windows XP, Windows 7, Windows 8 and Windows Vista. If
you run the Nord Sound Manager on a Windows computer, you also need a Clavia USB Driver of version 3.0 or later installed.

Installation

USB Driver

O Mac OSX users may skip this section.

The USB driver is installed automatically if the computer is connected
to the internet when the Nord instrument is connected to it. You can
then allow Windows to search for the driver. Here is how to make a
manual driver installation:

If you use a Windows computer (XP, Vista, 7 or 8), locate the
Clavia USB Driver v3.x Setup file, downloadable from www.nord-
keyboards.com and double click it.

Follow the instructions on the screen.

After the files have been installed, the driver will be activated when
you connect the Nord instrument. Do this by connecting a USB
cable between the Nord instrument and your computer.

@ When the Nord instrument is connected to the computer, the
driver will be automatically activated and a confirmation will appear
in the notification area in the Windows task bar.

Sound Manager

Windows users: Launch the “Nord Sound Manager v6.x Setup”
file and follow the instructions. The Nord Sound Manager can be
accessed from the start menu when the installation procedure is
finished.

Mac OSX users: Double-click on the “Nord Sound Manager
6.x.dmg” and then drag the Nord Sound Manager application
from the virtual hard drive to your “Applications” folder.

A The files mentioned for the driver and application installations
can be downloaded from the www.nordkeyboards.com website.
Please visit our website from time to time to check for any Nord
Sound Manager updates.

Overview

You can manage various types of content in the Nord instrument.
Depending on the Nord model, there may be Piano, Sample, Organ
Preset, Performance and Program partitions. These are accessed from
the tabs, labeled according to the partition they represent, for example
Piano, Samp Lib and Programs.

Only the appropriate tabs for each individual Nord model are avail-
able. The Nord Wave or C2D Organ are for instance not compatible
with the Nord Piano Library which means that the Manager will not
show a Piano tab if any of these models are used with the Nord Sound
Manager.

@ Certain features in the v6 version of the Manager are exclusive to
some models. If a Toolbar icon or a menu item is greyed out, this
means that the instrument you use is not compatible with that
particular feature.

A The actions that take place in the Nord Sound Manager will affect
the memory in the Nord instrument. The Manager is online with a
connected Nord at all times, any operations that you perform in
the Manager will immediately be executed in the Nord instrument.
If you for example delete a piano or a Program from the list in the
Nord Sound Manager, that sound will be deleted from the Nord
memory.

The Toolbar

The Toolbar at the top of the Manager window gives you direct access
to some of the most commonly used functions in the Nord Sound
Manager. Clicking on an icon will activate its corresponding function,
and a dialog will often appear asking for confirmation or further instruc-
tions from you.
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The Tabs

| Piano I Samp Lib| Program |S',rnth |

‘ Bank: |All 400 program: ¥

Select the memory area (partition) that you wish to work with by click-
ing its tab. As an example, the Piano and Samp Lib tabs allow you to
alter the content of the piano and sample partitions and the Program
tab allows you to organize the programs of your instrument. Pianos,
samples, programs or performances and other types will be referred to
as “sounds” throughout this manual.

& Press Ctrl+Tab on the computer keyboard to cycle between the
tabs.

The list of sounds can be ordered according to location, name, size,
version and date, in ascending and desce nding order. Just click on a
headline to select a preferred view.

Partition Memory Indicator

The memory indicator at the bottom of the window indicates how
much memory is being used in the selected partition. The dark area
shows the used memory, the bright indicates space that is available for
new sounds.

Right/Ctrl-Clicking

If you right/Ctrl-click on a sound, a context menu will provide options,
depending on what type of sound you selected.

Select in Instrument

Select In Instrument

This will select the chosen sound in the Nord
instrument.

Upload...

Download...

Substitute...

Upload

This will upload the selected sound from the
Nord instrument to the computer hard drive, to
a folder of your choice.

Relink proegrams...

Delete

Upload To Bundle (Programs/Performances)

This will upload the selected program(s) and any piano and/or sample
that this program uses, to a Bundle file on the hard drive. Bundles are
explained in greater detail on page 4.

Download

This is only available if you right-click on an
empty location that does not contain a sound.
This allows you to choose a file on the hard
drive, to be downloaded to the location in the
Nord instrument.

Substitute (Pianos & Samples)

This feature makes it possible to substitute a piano or a sample in the
instrument with another piano or sample from your hard drive. The pro-
cess will update all the programs that used the former piano/sample, to
use the new one after the substitution.

Relink (Programs)

Use the Relink feature if you want one or several selected programs to
use another piano or sample instead of the current sound. The sound
in question have to be present in the memory of the Nord instrument.
Relinking can also be used if a piano or sample is absent in the Nord
instrument, to repair programs that are missing a component.

Rename (Programs/Performances)

This allows you to rename, and assign a category to a program or
performance. Characters supported are: a-z, A-Z, 0-9 and a hyphen
(-). The name can contain up to 16 characters. Any other characters
will not be displayed in the Sound Manager lists.

® Pianos and samples cannot be renamed, this option will not be
available if you right-click on any of these.

Delete

This action will delete the selected sound(s) from the Nord instrument
memory.

File Formats

The Nord Sound Manager creates and/or uses files together with the
Nord instruments. The files are exclusive for each individual model,
the only exception to this are the Piano- and Sample Library files that
several models can use. The various types are identified by different
icons and the file extension with a model identifier and a type in the
following fashion:

Type Description
oMo Piano files from the Nord Piano
P Library.

Sample files from the Nord
.nsmp

Sample Library.

ends with “p” or Program and Performance

“pg” files.
ds with “pb”
endswih p Bundle fles.
or “bundle”
ends with “s” Synth program files.

ends with “op” Organ Preset files

ends with “b” Backup files.



The Quick Tour

Let’s get acquainted with some of the functions in the Nord Sound
Manager. If you perform the actions described in this tour, the content
in the Nord instrument may be changed, but you can always get back
to the factory content by restoring the instrument with the Factory
Restore file, available for download from www.nordkeyboards.com.

Backing up and restoring will be explained at the end of this tour, on
page 6. If you have made some changes to the content of the Nord
already, now would be a great time to do a Backup.

Transfer sounds to the Nord

When the Nord instrument leaves the factory, the Program, Perfor-
mance, Piano and the Samp Lib partitions are filled with sounds. In
order to be able to try out other pianos, you can delete one or two
pianos and load new ones and select this from the panel.

Deleting a sound

Open the appropriate Tab and select a piano or a sample to delete
and press the Delete icon in the toolbar.

You can also right-click on the sound and choose the Delete
option or use the backspace or delete keys on the computer
keyboard.

A dialog appears where you will be asked to confirm your intentions. If
any programs uses the soon-to-be deleted piano (or sample), you will
be alerted about this. If you confirm by clicking Yes, the sound in the
Nord instrument will be deleted.

& Ifyou delete a piano or sample that is used by any programs,
these programs will then be missing an important part. This can
be fixed by downloading the same sound at a later time.

Download a new sound

Using drag and drop: Open the folder on the computer hard
drive where the new sound is located.

Make sure that the Sound Manager window and the folder are
visible on the screen.

Drag the new sound to the white area in the Sound Manager list.
When the cursor gets a plus-sign, release the mouse button.

@ The Clean Deleted Space process will start to prepare the
memory and then the new piano will be downloaded to the Nord
instrument. If there isn’t enough free space to complete the opera-
tion, a message about this will appear.

& If the Organize view is active, you can drop a sound on any free
location in the bank. If this is not active, the new sound will be
automatically placed at the first free location in the bank.

@ The pianos are categorized and can only be added to the bank
they belong to; electric pianos cannot be added to the grand
bank, grand’s cannot be dropped in the clavinet bank etc.
Samples can only be added to the Samp Lib partition, Programs
to the program etc.

NORD SOUND MANAGER

Adding a sound using the Toolbar or Menu command: Click
on the Sound Down icon in the toolbar. The same command is
also available in the File menu: Sound Download (Ctrl-D).

Browse to the folder on the hard drive where the desired sound is
located, select it and click Open. The sound will now be added to
the bank at the first free location.

Substitute

The Substitute feature replaces a piano or sample in the Nord instru-
ment with another one that you want to use. There are many different
sample instruments available for download from the www.nordkey-
boards.com website.

Substituting a piano/sample with another will automatically update
all the Programs that used the previous sound to use the new sound
instead.

Open the Piano or Sample tab. The current content of the partition
in the Nord instrument will be displayed.

Select a sound in the list that you wish to substitute with a new
one and click the Substitute icon in the toolbar.

& You can also right-click the sound and choose the Substitute
option or use the Substitute command in the Edit Menu.

Substitute @I

|6’| This will delete "Black Upright Petrof Med 5.3", download a
" replacement piano and relink the affected programs to use the
replacement instead.

Substitute

Mo file selected.

Substitute

Cancel

The Substitute dialog informs you about the action about to take place.
Click Browse to locate a new sound on the computer hard drive.

Press Open and then confirm by clicking Substitute.

The substitution will begin by deleting the original sound, then cleaning
the memory, downloading the new sound and finally relinking all the
programs to the new sound.

& If you use Susbtitute to try a sound and then change your mind,
just substitute the new one with the previous one to get back to
where you started from.
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Relink

Relink is a powerful feature that makes it possible to change the piano
or sample (or both) that one or several programs use. Let’s imagine
that you have downloaded a new favorite grand piano and want to
change the programs that used your previous favorite grand, to the
new one instead. Instead of manually changing every program on the
instrument, Relink can achieve this in the Nord Sound Manager.

Let’s Relink a program, to change what sound(s) the program should
use.

Open the Program tab and right-click a program in the list.

Select the Relink Samp Lib option in the context menu. The menu
will expand to show the sample that is linked to this program.

Select the sample and let go of the mouse button. This will open
the Relink dialog where you can choose the new sound that the
program should use instead.

@ Click Relink to relink the program to the new sound.

@ You can only Relink programs to a sound that is already present in
the Nord instrument.

Download Queue

You can add several sounds, one by one, using the drop method, or
with the Toolbar or Menu commands. These sounds will be put in the
download queue. The memory will be cleaned if needed and the files
will be downloaded to the instrument in the order they were added to
the queue.

Select the desired partition that holds the type of sounds that you
wish to load.

Drag a sound from the computer hard drive to the white area in
the Sound Manager list.

Drag another sound to the white area in the Sound Manager list.

Files that are placed in the queue will be displayed in bold.

If you wish to cancel an ongoing queue, you can either delete all
files that are queued or press the Cancel button. During the Clean
process the Cancel option is not available.

Files waiting in the queue can be deleted from the queue if you change
your mind. Right-click on the queued sound or use the Toolbar or
Menu Delete command.

& Files already in the instrument can be moved or deleted during the
processing of the queue.

Upload sounds from the instrument

Select the desired partition that holds the sounds that you wish to
store on the computer hard drive.

Select the bank and the sound(s). Shift-click will allow you to se-
lect several consecutive sounds; Ctrl-click will allow you to select
nonconsecutive sounds. Here is a selection of a few programs:

Click the Sound Up icon or right-click the selected sound(s) and
select Upload. The dialog will prompt you to browse to the desired
destination folder on the hard drive. The upload process may take
a few moments depending on the size of the sounds.

Program/Performance Bundles

A Program/Performance Bundle contains one or several programs/per-
formances, and all the pianos and samples that these programs use, in
one file. Bundles are great to store parts of the memory from your Nord
instrument. If you select one program and create a Bundle, the Bundle
will be pretty small in size, and the uploading process will be reason-
ably quick, compared to a complete Backup procedure.

You can also create another Bundle with all the programs you need for

a specific performance, and when you need those programs again, the
Bundle functionality will restore them and their associated sound files to
the Nord instrument.

Not all Nord instruments are compatible with the Bundle feature. Look
at the Sound Manager page on the Nord website for further details.

® Pianos and samples that are used by several programs will not be
duplicated in a Bundle, nor will they be downloaded back to the
instrument if they already are in place in the instrument.



Upload a Program Bundle

Open the Program Tab and select one, or several programs. Use
Ctrl-click to make non-consecutive selections like this one:

Bank = Loca... Name
Bank A 01:1 Halian Grand
Bank A 01:2 B3 Jazz Spell FS
Bank & 01:3 Quartet-Orch MW
Bank A 01:4 SparkleTop
Bank A 01:5 Lisa EX
Bank A 02:1 Mellow Upright
Bank A 02:2 B3 Gospelly MW
Bank A 02:3 Grand Peggio MW
Bank A 02:4 Tom Sawyer AT

Bank A 02:5 Darjeeling

Bank A 03:1 Grand Lady D

Bank A 03:2 Split M-Tron

Bank A 03:3 Clavinet A

Click on the Bundle Up icon in the Toolbar.

The Program Bundle Upload dialog gives you two choices:

Program Bundle Upload @

Program Bundle Upload

W This will uplead one or more programs and their used
pianos/samples to a Program Bundle.

Source

(©)Selection (3 programs}

()Bank Bank A (100 programs) ¥

Selection will create a Program Bundle with the selection of programs
you made in the Nord Sound Manager program list and the pianos
and/or samples that these programs use.

Bank makes a Bundle of an entire Bank that you select with the
drop-down. This action will probably take a bit longer and the resulting
Bundle will be a bigger file since there may be many more pianos and
samples in this type of Bundle.

Choose the Selection option and click on Upload. In the following
dialog, give the Bundle a meaningful name and find a location on
the computer hard drive.

Downloading a Bundle

Here comes the really great part about Bundles. When you download
a Bundle to the instrument, any pianos and samples that the programs
in the Bundle depend on, are downloaded. They will be placed at the
next available location in the piano and/or Samp Lib partition.

@ Pianos and samples are not duplicated if these files are already in
the instrument. The Bundle programs will use the new or existing
locations of the pianos and samples, when they are downloaded
to the free locations in the program partition.

Make sure the Program Tab is open.

& &

Press the Bundle Down icon in the Toolbar. You can also use the
Bundle Download command from the File menu (Ctrl+Shift+D).

Navigate to the Bundle file that you wish to download and click
Open.

NORD SOUND MANAGER

After the Manager has verified the files in the Bundle, the Program
Bundle Download dialog will appear.

& Click on Show Details if you want to see what programs, pianos
and samples are in the Bundle.

Program Bundle Download @

Program Bundle Download

This will download the programs in the Program Bundle to the
destination bank, including all used pianos/samples.

Source

Program Bundle: "Hit Parade"

Destination

() Add to bank

Bank D (100 programs) v

(@) Replace the entire contents of bank

Hide Details <<

All pianos/samples are already downloaded.

[ pownload | [ cancel |

Program Bundle contains 3 programs:

tron Flut

urlitzer 1 20 3 [6.0 MB] (already download
aa Female Oh__ SR ste 2.0 [2.1 MB] (already downloaded)
wmm Quartet-Orch MW

- Split M-Tron

There are two options when you download a Bundle.

Add to bank will download the program files and add them to the
program bank that you choose in the drop-down menu. The programs
will be placed at the first available locations.

@ If the programs in the Bundle will not fit in the Bank, the process
will not be performed and you will see a message about this.
Delete or move some programs from that Bank and try again.

Replace contents in a bank will simply delete all programs in the
Bank you choose and download the programs in the Bundle to this
bank instead. The programs will be placed at the same locations as
they had when the bundle was created.

If a bundle will not fit in a bank, this will be presented in the dialog like
in the image below where more free locations are needed in the
program bank:

Program Bundle Download @

Program Bundle Download

m This will download the programs in the Program Bundle to the
destination bank, including all used pianos/samples.

Source

Program Bundle: "Hit Parade"

Destination

Bank A (100 programs)

(") Replace the entire contents of bank

A, Bank requires 3 additional free locations.

Show Details == Download
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Organize the program partition

By using drag and drop, you can organize the content of the Program
partition(s).

Make sure that Organize is turned on in the View menu.

Select and drag a program from the destination location to the
desired location.

If you drop a sound on a free location, the sound will be moved
from the source location. If you drop it on a location that is oc-
cupied, the two sounds will change locations.

Select a program and press the Ctrl-key on the computer key-
board. If you now drag this selection, the Program will be copied
and pasted at the destination instead of just being moved.

Search Box

By entering one or several characters in the Search Box, you can filter

out the content that is presented in the lists.

This provides you with a quick way to find duplicate programs, etc.

Q vinlin|

Auto Select

By clicking on the Auto Select icon in the toolbar, you toggle the Auto
Select function on or off.

When Auto Select is turned on and you scroll
through the pianos, samples or program lists using
the computer keyboard arrow keys, the sounds will
automatically be selected in the Nord instrument.

& Double-clicking on a piano, sample or program will also make it
active in the Nord instrument.

Backup

Click on the Backup icon to make a backup file that contains all
the content in your Nord instrument.

The Nord instruments are built
to the highest standards of reli-
ability but doing regular backups
is always a good thing.

Give the backup file a meaningful name and find a suitable loca-
tion on your hard drive.

& If you choose a backup file that already exists, only the changes

that have occurred in the instrument will be added to that previous

file.

Restore

When you want to restore the entire content of the Nord instrument,
click on the Restore icon in the Toolbar and select a backup file that
you have made. You can also drag the backup file from the computer
and drop it to the Manager window.

The Confirm Restore dialog will appear that requires your confirmation.
You can look at the content of the file if you click on “Show Details”.

(=5

The contents of your instrument will be replaced by the
contents of backup archive "Mord Stage 2 EX Factory Restore
v2.06 revA".

Restore

Restore ] l Cancel ]

Backup archive contents:

£ Live
-D Piano
(B Program
-D Samp Lib
-E Settings
-D Synth

There are Factory Restore files available for all Nord instruments, which
can be used to restore the content of the instrument to that which it
was shipped with. The files are available for downloaded from www.
nordkeyboards.com.



Sound Manager reference

Toolbar

Info

Activating Info brings up an information area to the right of the list.

2 GrandLadyD StwD Lrg
3 Bright Grand YaS4 Med
4 Studio Grand 2 YaC7 Lrg

5 EGrand 3 Amped CP80 mono... Bank  loc Name

1 Grand Upright YaU3 Lrg Bank A 15:1 Peters Grand
2 Mellow Upright Bdrf C130 Med
3 Black Upright Petrof Med

4 Queen Upright Bdorf Med

5 Romantic Upright Schimmel ...
6 Saloon Upright Baumgardt M...
7

1

2

3

Il EGrand 3 Amped CP80 mono Sml 5.3
Used by 6 programs:

Bank B 10:4  Arpamed MW
Bank C  02:2 RubbaMix FS
Bank C  05:5 CP80 Amped

Bank C  09:1 DxheavenMW FS

HonkyTonkUpright — Sml BankD  15:1 Peters Grand
EFiano 1 Mk ILow Deep
EFiano 2 Mk I ClosIdeal

EPiano 3 Mk II Shallow

The Info area will show if a selected piano or a sample is used in any
Programs, or what pianos and samples are used in any selected
Programs. This provides you with an excellent way of keeping track of
how the content components in the Nord instrument depends on each
other.

01:1 DX Full Tines Info
01:2 Grand Strings
2 programs selected:
01:2 B3 Ethel Smith
01:4 PulsyCimbalom FS PulsyCimbalom FS
01:5 Softwurl MW =] Using 3 pianos/samples:
02:1 Attack Bass
02:2 Osc-Orgy . Slot  Bank Loc Name
02:3 Rick W @ SlotA  Grand 1 Italian Grand Faz XL 5.3
02:4 MNew Frontier & Slot A Samp Lib 125 CimbalomHard__PS ste 2.0
& site  Grand 1 Ttalian Grand Faz XL 5.3
03:1 80 Pi-layer MW & ciots (Mo sample)
03:2 UkrainianBandura
. - < | ] | »

03:2 B3 Full Tibias
03:4 Japanese
03:5 Filter Tapdance Brandenburg
04:1 Spain [ Using 4 pianos/samples:
04:2 GlassOrgan Slot  Bank Loc Name
04:3 L | T

cgical Tramp @ spta Harps 2 French Harpsi 1D Lo8 Lo4 5.1
04:4 Techno Tron - . -
04:5 Dont Jump AT E SlotA Samplib 19 StudioStr Leg_Vib_KH ste 2.(
05:1 WheelOfFortune W= SlotB  Harps 2 French Harpsi 1D Lo8 Lo4 5.1
05:2 GirlsOnlymw MC & SiotB Samp Lib 45  All Winds __ SR ste 2.0
05:3 Hidden Valley MW < m ‘ b
05:4  Kraftwheel

Let’s say you need to delete some of the factory samples to make
room for new samples. By selecting a sample in the Samp Lib partition
and activating Info, you can see which of the programs that would be
affected by such a deletion (or replacement).

Organize

When this option is active, the lists will show all the available locations

in the selected partition/bank and not only the occupied ones. This will
for instance make it possible to drag a file to a specific free location in

the middle of the list. If this is inactive, only the occupied locations will

be shown and re-arranging the order is not possible.

Dual View

When this option is checked, the window (if set to display the Program
partition) will be divided in two lists. You can make the lists show sepa-
rate banks with the drop-downs. Rearranging programs is simply a
matter of drag and drop. Drag a program from one bank/list to another
bank/list in either direction.

NORD SOUND MANAGER

Auto Select

With this function active, scrolling through the piano, sample or
program list with the computer keyboard arrow keys will automatically
select the sound in the Nord instrument.

Rename

This allows you to rename a program. 16 characters can be used, and
the supported characters are: a-z, A-Z, 0-9 and the hyphen (-). Any
other characters will not be displayed in the Sound Manager lists.

@ Pianos or samples cannot be renamed so this function is not
available if you have selected any of these.

Delete

Allows you to delete one or several selected sounds. You will be asked
to confirm your intentions. You may also use the delete or backspace
key on the computer keyboard to perform this action.

@ Any Program in the Nord instrument that used a particular piano
or sample that you deleted will probably not sound at all, since it
will be missing an important component.

The space that a deleted piano occupied is not immediately available
to other sounds, even though it is gone from the list and its location
is free. The Flash memory needs to be cleaned to free up the space
where the deleted sounds have been. When you add a new piano
the cleaning process will be initiated automatically. You also have the
option to manually start the cleaning process with the Clean Deleted
Space command from the File menu.

©  Flashing LEDs in the Piano Type and Model section indicates that
the piano that the current program tried to use is not available in
the Nord instrument memory. Select another program or down-
load the missing piano to the Nord instrument.

Substitute

Substitute allows you to replace a selected piano or a sample with
another piano or sample that you have on the computer hard drive.

This function is not only about replacing the sound file in the memory,
all the programs that used the old sound, will be updated, relinked to
use the new sound instead.

Substitute @

- j  Thiswill delete "Black Upright Petrof Med 5.3", download a
& replacement piano and relink the affected programs to use the

replacement instead.

Substitute

Mo file selected.

Substitute

Cancel

Relink

Use the Relink feature if you want one or several selected programs to
use another piano or sample instead of the current sound. The sound
in question have to be present in the memory of the Nord instrument.
Relinking can also be used if a piano or sample is absent in the Nord
instrument, to repair the programs that are missing a component.

® Not all Nord instruments are compatible with the Substitute and
Relink features. In these cases the toolbar icons will be grayed
out.
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Sound Up

Use this function to upload one or several sounds from the Nord
instrument to the computer hard drive.

The Sound Up
dialog allows you
to choose either
the current selec-
tion of sounds or
an entire bank.

Program Upload @

Pregram Upload

This will upload ane or more programs from the instrument.

- If source is set to Bank, the programs will be put in a folder with the
same name as the source bank.

Source

(") selection (1 program)

(@Bank |BankB (100 programs) ¥

Clicking Upload
brings up a file
dialog where you

select a location for the files on the computer hard drive.

Sound Down

Use Sound Download to download one or several sounds from the
computer hard drive to the next available location in the selected parti-
tion.

The Sound Down dialog gives you a few choices regarding the source
files and their destination.

Source Files is the

K Program Download @
option when you
want to browse
for, and select

Program Download
- This will download programs to the destination bank in instrument.

Source

individual files Flease browse for programs to download.
on the computer Browse for [_Fil
hard drive.

Destination

. () Add to bank
Source Folder is

, (© Replace the entire contents of bank
the option when Bank A (100 programs)
Bank B (100 programs)
you want to S - Bank C (100 programs)
Slimy BEED Bank D (100 programs)
browse for and
select an entire

folder that contains sounds; all of the folder content will be downloaded
to the instrument.

@ The files in the folder have to be of the same kind.

Destination Add to bank will add the selected source files to the bank
you select in the drop down menu. If the number of source sounds
does not fit in the destination bank, a message will appear.

Destination Replace the content in bank will delete all the sounds in the
selected bank in the instrument and replace those with the source files.

Show Details will list the source files before they are downloaded to the
instrument.

Bundle Up
. . Program Bundle Upload
This function (X
will up|Oad Program Bundle Upload
. m This will upload one or more programs and their used

a selection pianos/samples to a Program Bundle.
of programs source
or an entire (") Selection (1 program)
Bank to the
CompUter hard Bank A (100 programs]
drive, and Bank B (100 programs)

’ Bank C (100 programs)
include all the Bank D (100 programs)

pianos and/or
samples that these programs use in a Program Bundle file.

The default source will be the currently selected Program(s) or the ac-
tive bank, but you can choose another bank with the drop down menu.

Click on the Upload button to enter the name of the Bundle and to
select the destination on the hard drive. The Program Bundle file that is
created on the hard drive will have a file extension that ends with “pb”.

Bundle Down

This function will download a Bundle with programs, pianos and
samples from the computer hard drive to the Nord instrument. You
have a choice if you want the Bundle to be appended to the existing
programs in the bank in focus or if the Bundle should replace the
contents in an entire bank of your choice.

Program Bundle Download

=

Source

(el

Program Bundle Download

This will download the programs in the Program Bundle to the
destination bank, including all used pianos/samples.

Program Bundle: "Hit Parade"

Destination

(") Add to bank

Bank D (100 programs) ¥

(@) Replace the entire contents of bank

Hide Details <<

All pianos/samples are already downloaded.

[Downloadl l Cancel I

Program Bundle contains 3 programs:

om Female Oh__SR ste 2.0 [2.1 MB] (already downloaded)
Quartet-Orch MW

wm Split M-Tron

Programs in a Program Bundle will be downloaded to the locations
where they came from if the Replace option is selected.

® Not all Nord instruments are compatible with the Bundle feature.

Backup

This will make a backup of all the pianos, samples, programs, and in
some instruments also the live programs and the menu settings. Back-
ing up the entire memory content in this manner will take some time,
depending on the sizes of the pianos and samples installed.

& Backing up from the Nord Sound Manager is done in an incre-
mental manner. Unless you change the name or the location of
the backup file, only the pianos and/or programs that have been
changed since the previous backup will be saved.

The Nord Sound Manager will suggest a location for the backup the
first time this function is selected (in My Documents/Nord Sound Man-
ager files/). If you'd rather save the backup file elsewhere, use the file
dialog to pick another destination.

Restore

To restore a previously saved backup file to the Nord instrument, select
this option and browse to a backup file on the hard drive and click
Open.

A The restore process will begin after you have clicked Open and
confirmed your intentions in the dialog. All the content that isn’t in
the backup file in a connected Nord instrument will then be irrevo-
cably replaced by the content in the backup file.



Menus

The usual Windows and Mac OSX keyboard commands can be used
in the Nord Sound Manager. The menus can be accessed by pressing
the Alt key and the underlined letter in the menu bar.

Most of the commands can also be accessed by pressing the Ctrl (on
the Mac - Command) key together with the letter shown next to the
command name in the menus.

File menu

Sound Upload (Ctrl+U)

Use this function to upload
one or several sounds from the
Nord instrument’s memory to
a folder on the computer hard
drive.

Sound Download (Ctrl+D)

Use this function to download
one or several sounds from the computer hard drive to the next avail-
able location in the selected partition.

Look at page 8 for a detailed description of Sound Up and Sound
Down.

Program Bundle Upload (Ctrl+Shift+U)

This function will upload a selection of programs or an entire Bank to
the computer hard drive, and include all the pianos and/or samples
that these programs use in a Program Bundle file.

The default Program Bundle Upload =
source will

be the cur-
rently selected
program(s)
orthe active | OResfenliand
bank, but you () Bank
can choose
another bank
with the drop
down menu.

Program Bundle Upload

m This will upload one or more programs and their used
pianos/samples to a Program Bundle.

Source

Bank A (100 programs) ¥

Click on the Upload button to enter the name of the Bundle and to
select the destination on the hard drive. The Program Bundle file that is
created on the hard drive will have a file extension that ends with “pb”.

Program Bundle Download (Ctrl+Shift+D)

This function will download a Bundle with programs, pianos and
samples from
the computer
hard drive to
the Nord in-
strument. You Source
have a choice
if you want
the Bundle to
be added to
the existing
programs in
the bank in
focus or if the
Bundle should replace the contents in an entire bank of your choice.

(=5

Program Bundle Download

Program Bundle Download

This will download the programs in the Program Bundle to the
destination bank, including all used pianos/samples.

Program Bundle: "Hit Parade"

Destination

() Add to bank

(@) Replace the entire contents of bank BADID( oA s) ety
Show Details =>

[Dﬂwnload] l Cancel I

@ Not all Nord instruments are compatible with the Bundle feature.

NORD SOUND MANAGER

Backup (Ctrl+B)

This will make a backup of all the pianos, samples, programs, perfor-
mances, Live programs and the menu settings in the Nord instrument.
Backing up the entire memory content in this manner will take some
time, depending on the sizes of the pianos and samples installed.

& Backing up from the Nord Sound Manager is done in an incre-
mental manner. Unless you change the name or the location of
the backup file, only the pianos and/or programs that have been
changed since the previous backup will be saved.

The Nord Sound Manager will suggest a location for the backup,
the first time this function is selected (in My Documents/Nord Sound
Manager files/). If you rather keep the backup file elsewhere, use the
browser to pick another location.

Restore (Ctrl+R)

To restore a previously saved backup file to the Nord instrument, select
this option and browse to a backup file on the hard drive and click
Open.

A The restore process will begin after you have clicked Open and
confirmed your intentions in the dialog. All the content of a con-
nected Nord instrument will then be irrevocably replaced by the
content of the backup file.

Clean Deleted Space

This function will clean up the space where any previously deleted pia-
nos or programs have been. This is done in order to make this deleted
memory space available to new additions.

©® Cleaning is automatically done if you download a new piano or
program to the Nord instrument, but this menu command makes
it possible to manually start the cleaning process.

Format

This is a radical function; it will format the entire partition that is in
focus. All the sounds in the partition will be deleted. You will be asked
to confirm your intentions. Do not show your cat this.

Export Sound Lists

The Export command will create a set of text-based lists of the content
in the instrument, saved to location of your choice. The number of lists
created depends on the type of instrument. The lists contain informa-
tion with the names, locations and sizes of pianos and samples, the
program list also contain information of which piano and/or samples
are used for every program in the instrument.

The lists are formatted in a .html format. Double-click on a list to view it
with a web browser, an application that probably can print them for you
as well. The lists can be opened with a spreadsheet application, if you
wish to perform further manipulation.

Exit (Ctrl+Q)
Exits the Nord Sound Manager application.

Edit menu

Rename (Ctrl+N)

This allows you to rename a pro-
gram. 16 characters can be used,
the supported characters are: a-z,
A-Z, 0-9 and the hyphen (-). Any
other characters will not be dis-
played in the Sound Manager lists.

@ Pianos or samples cannot be renamed so this function is not
available if you have selected any of these.

9
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Delete (Del)

Allows you to delete a selected item(s) from the Nord instrument’s
memory.

A A dialog will appear with information if this action will affect any
programs in the Nord instrument, that uses these sound. You will
be asked to confirm your intentions.

Substitute (Ctrl+T)

This allows you to replace a selected piano or a sample with another
piano or sample that you have on the computer hard drive. This will
also change all programs that used the previous sound, to the new
sound instead.

Relink (Ctrl+K)

Use the Relink feature if you want one or several selected programs to
use another piano or sample instead of the current sound. The sound
in question have to be present in the memory of the Nord instrument.
Relinking can also be used if a piano or sample is absent in the Nord
instrument, to repair the programs that are missing a component.

@ Not all Nord instruments are compatible with the Substitute and
Relink features, in which case these items will be grayed out.

Select All (Ctrl+A)

Select all items in a bank/partition.

Invert Selection

This will deselect the original selection and then select all the other
items in the list.

View menu

Organize (Ctrl+0)

When this option is checked, the lists

will show all the available locations in

the selected partition/bank and not

only the occupied ones.

This will for instance make it easier to

drag a file to a specific free location

in the middle of the list. If this is unchecked, only the occupied loca-
tions will be shown.

Dual View (Ctrl+L)

When this option is checked, the window will be divided in two lists.
The two lists makes it easy to move programs from one location to
another. You can make the lists show separate banks with the drop-
downs. Rearranging programs is simply a matter of drag and drop.
Drag a program from one bank/list to another bank/list in either direc-
tion.

& Press the Ctrl-key on the computer keyboard before dragging to
copy a selection to the destination during a drag and drop opera-
tion.

Info (Ctrl+1)

Activating Info brings up an information area to the right of the list.

2 Grand Lady D StwD Lrg Il EGrand 3 Amped CP80 mono Sml 5.3
3 Bright Grand YaS4 Med
4 Studio Grand 2 YaC7 Lrg
1 Grand Upright YaU3 Lrg
2 Mellow Upright Bdrf C130 Med
3 Black Upright Petrof Med
4 Queen Upright Bdorf Med
5 Romantic Upright Schimmel ...
6
7
1
2
3

Used by 6 programs:

Bank Loc Name

Bank A  15:1 Peters Grand

Bank B 10:4 Arpamed MW
Bank C  02:2 RubbaMix FS
Bank C  05:5 CP80 Amped

Bank C  09:1 DXheavenMW FS
Bank D  15:1 Peters Grand

Saloon Upright Baumgardt M...
HonkyTonkUpright  Sml
EPiano 1 Mk ILow Deep
EPFiano 2 Mk I ClosIdeal
EPiano 3 Mk I Shallow

This area will show if a selected piano or a sample is used in any
programs, or what pianos and samples are used in any selected
programs.

01:1 DX Full Tines Info
01:2 Grand Strings
01:3 B3 Ethel Smith 2 programs selected:
01:4 PulsyCimbalom FS PulsyCimbalom FS
01:5 Softwurl MW d Using 3 pianos/samples:
02:1 Aftack Bass
Slot  Bank Loc Name

02:2 Osc-Orgy ™
02:3 Rick W == SlotA  Grand 1 Italian Grand Faz XL 5.3
02:4 New Frontier & slota Samp Lib 125 CimbalomHard__PS ste 2.0
02:5 Brandenburg & siotB  Grand 1 Italian Grand Faz XL 5.3
03:1 80 Pi-layer MW & siote (o sample)
03:2 UkrainianBandura
03:3 B3 Full Tibias <l I | ¢»
03:4 Japanese
03:5 Filter Tapdance Brandenburg
04:1 Spain [ Using 4 pianos/samples:
04:2 GlassOrgan Slot  Bank Loc Name
04:3  Logical Tr

cgical Tramp & siota Harps 2 French Harpsi 1D Lo8 Lo4 5.1
04:4 Techno Tron o ) ]
04:5 Dont Jump AT == SlotA  Samplib 19 StudioStr Leg_Vib_KH ste 2.(
05:1 WheelOfFortune & slts Harps 2 French Harpsi 1D Lo8 Lo4 5.1
05:2 GirlsOnlymw mMC - SlotB  Samp Lib 45 All Winds __SR ste 2.0
05:3 Hidden Valley MW < o | ,
05:4 Kraftwheel

Find Ctrl+F

This is a shortcut to the Search Box. By entering one or several charac-
ters in the Search Box, you can filter out the content that is presented
in the lists.

Auto Select

When this function is active, pianos, samples or programs will be auto-
matically selected in the Nord instrument when you browse through the
sounds in the Manager list, with the computer keyboard arrow keys.

Help menu aboLt...

About

Brings up the About box with a information regarding the version of the
Nord Sound Manager. You will also see a list of compatible instruments
and OS versions.



Tabs

|Pian0 |Samp Lib| Program |Syﬂth |

‘ Bank: |All 400 program: ¥

Piano — Samp Lib - Program - Performance

Use the tabs to select the desired partition. The drop down menu is
used to select the desired bank within the piano, sample or program
partitions. The content of the partition will be presented in the list.

& Press the Ctrl + Tab keys on the computer keyboard to cycle
between the tabs.

Search Box

Enter a phrase to quickly shown any pianos or programs that contains
the characters in their names. Press Clear to clear the filtering and
show all entries again.

Loc - Location

The banks are organized in locations; the number of locations varies for
the different bank types.

Name

The name of the item.

Size

Shows the file size of the pianos and samples. This may be useful if
you need to know how much space for example a particular piano oc-
cupies in the piano partition. This unit is not shown in the program lists.

Ver — Version Number

This indicates the version number of the actual piano, sample or
program format. Older OS versions may not be able to use sounds in a
newer format.

Note

This area contains various information messages regarding the memory
content in the Nord instrument. If a piano or sample is not used by any

of the programs, it will be indicated here. This area is also used to alert

you if a piano or a sample that a program in the Nord instrument would
use, is missing from the instrument.

On a rare occasion that something happens with any of the files in
the instrument, error information about broken, corrupted or rejected
files, will be displayed here. If this happens, delete the broken file and
download it again to the instrument.

Footer Area

The footer area is located at the bottom of the Nord Sound Manager
window.

NORD SOUND MANAGER

Partition Memory Indicator

This indicates the usage of the selected partition’s memory. The dark
area shows the used memory and the brighter area indicates space
that is available for additional sounds.

Cancel Button

Use this function if you need to cancel a process that is in progress.
Certain actions like a restore process cannot be cancelled once they
have been started.

Progress Bar

The progress bar indicate the progress of an ongoing process.

Message/Text Area

The left part of the text area will present any confirmations or error
messages from the Nord Sound Manager.

The right part will indicate of a Nord instrument is connected to the
computer and in communication with the Nord Sound Manager. The
OS version of the connected Nord instrument will also be displayed
here.

Updates and sounds

Please visit our website at http://www.nordkeyboards.com to down-
load any updates of the Nord Sound Manager and sounds that have
been released for the Nord instrument. These items will be available as
free downloads in the Download area and in the Libraries areas.
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